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INTRODUCTION

USING THIS MANUAL
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ShowOff is an easy-to-use program that lets you select, assemble, and display
professional looking screen images in minutes. Never before has it been so easy to produce
effective presentations. You can create a slide show for your computer, print your creations
on paper, or make transparencies for an overhead projector with equal ease.

ShowOff provides everything you need to create you own:

¢ Lecture demonstrations
* Story boards

* Self-running slide shows
* Reports

 Visual aids

* ... And much more!

Anyone can use the hundreds of images supplied with ShowOff to create screen slides
or printed pictures that might take weeks for an art department to produce. ShowOff
requires no particular knowledge of computer programming or graphics, no artistic
training. Just point and click and ShowOff does the rest.

This manual is your complete guide to the capabilities of ShowOff. The first
chapter, “Using ShowOff” tells you what you will need in order to use the program, and
how to get started. Then there’s a brief overview of ShowOff’s functions and a hands-on
guided tour. In the guided tour you will assemble your first ShowOff frame using a
background, border, icons, and text.

Chapter 2 is a detailed description of the functions available in the Frame Editor. Here
you will find everything you need to know in order to design and create your own
ShowOff frames.

In chapter 3 you will learn how to use the Icon Editor to create your own icons or
modify the icons supplied with ShowOff.

Chapter 4 describes the Sequence Editor where you will arrange your frames into an
organized, coordinated slide show.

The Label Editor, described in chapter 5, lets you design and print your own custom
labels for your data disks and self-running slide show disks.

Chapter 6 is filled with suggestions and examples to guide you in planning, creating,
and printing your own presentations.

Chapter 7 and Chapter 8 provide a quick reference to the library of icons and borders
included with ShowOff.

In no time at all, you’ll be making dazzling presentations just like an expert. In fact,
you’ll be an expert! So without any delay, let’s get started. . . .

Welcome to ShowOff!



USING SHOWOFF

WHAT YOU WILL NEED

STARTING SHOWOFF
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OVERVIEW

* Apple IIGs with at least 512K memory and a double-sided disk drive.
TV or Color monitor

* A mouse.

* Blank disks for saving icons and slides you create

Optional:

* Printer (refer to the ShowOff package for a list of printers you may use with this
program)

* Pinfeed paper or Acetate.

» Color ribbons

To start ShowOff, simply insert the program diskette into your startup drive, turn on
your monitor and switch on your Apple IIGs. The program will load and after a few
moments, the title screen will appear. A few moments later the menu bar will appear at the
top of the screen, and a toolbox on the left side of the screen.

Using ShowOff you will be able to produce your own colorful, contemporary visual
aids in minutes. Professional looking overhead transparencies, on-screen “slide shows,”
even posters and handouts are equally easy. ShowOff even helps you control a 35mm slide
projector and make it part of a multimedia presentation.

ShowOff is fast. You can build a complete transparency or “slide” in less than two
minutes using ShowOff’s pull-down menus and a mouse. A library of over 380 custom
graphics and 144 borders is at your disposal. You can create your own graphics in
ShowOff’s icon editor or import graphics or pictures from other programs. Everything you
need is right here.

ShowOff is foolproof. Your transparency or “slide” always turns out exactly the way
you expect it to, because what you see on your screen is just what you get. You can move
things around until they are right where you want them, and if you want to change things
later, that’s easy too. Visual aids cost pennies to create with ShowOff, so you never have
to settle for something you don’t really like because it would take too long and cost too
much to change it.

ShowOff is fun. Creating visual aids used to be drudgery. Now ShowOff makes it fun
as well as easy. Your presentation is more enjoyable too, for you as well as for your
listeners. The gradeschool class, the scout troop, and the service organization will learn
faster and have more fun. Business meetings will be more convincing. You will feel more
confident and your ideas will be easier to understand. Good visual aids make any
presentation more effective. now turn the page to start a guided tour of ShowOff and add
to little showmanship to your next presentation.



A GUIDED TOUR When you have started ShowOff as described above. you are ready to create your first
screen. Insert the Data Disk and open the File Menu by pointing to the word “File” with
the cursor, pressing and holding the mouse button. Select the option “New” in the File
Menu by dragging the highlight to it and releasing the mouse button.

(ot JIRY Edit Goodies Graphics Special |

Open a0
Load Picture
Save a5
Save fis

Save as Bitmap
Print aP
Quit (A1)

A dialog box will appear, with the name of your disk and the amount of available
storage space. At the bottom left of the window, under “Name of new sequence?”, the
name Untitled1 will appear. Just type in a name for the new sequence you are going to
create and press Return (or click on Save).

/Showoff/
Free: 115k out of 800k. (
L B omds

D Bmaptian

Cancel ]

(Mew Folder )

O Border ‘.

Y Brader Presents 4 Liose J
O Icon _

i Imagel L Disk )
Name of new sequence ?{ Bnen y
Untitledl

Now, let’s create a frame: Pull down the Graphics Menu and‘select “Background”.

[#8 File Edit Goodies QHELLICEE Special
Background

Sticker
Icon al
Border aB

Pa Bardoer
Shaw fempiate
Fonts tF

A window will appear with the palette of 16 colors you may choose from.

Background color
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Use the mouse to move the cursor to the light grey square in the palette and select it
by clicking the button. The chosen color will be displayed in the square at the right of the
window. Click on “OK” to confirm your choice. ShowOff will change the background
color to the one you have chosen. You can now complete your frame with all the custom

features included in ShowOff.

First, let’s put a border around the screen. Select “Border” in the Graphics Menu. On
your screen, a selection window will appear, showing 42 borders. You can see more
choices by clicking on the arrows in the scroll bar at the right side of the screen.

Select a Border

it -
'“!'L v —
I i A

Select a border by pointing at it with the cursor and clicking the mouse button, then
click on “Select” to confirm your choice.

The chosen border will automatically be displayed on the screen.

&

o File Edit Goodies Graphics Special

/18
3ol

2
&

O[0[0
LI

Now press the space bar to see the full screen. When you have examined your frame,
press the space bar again to return to the Frame Editor.



Next, we’ll put a graphic object into the frame. Select “Icon” in the Graphics Menu.

Select an Icon Alphabet

(Select ) ( Cancel ) [ Add ] [ Remove )

[ pi‘ii

U,

A window will appear on the screen with a selection of 35 icons. Notice that the word
“Alphabet” appears in the upper right corner of the screen. This is the name of the Icon
Library page you are viewing. You can browse through the library of icons in ShowOff by
using the scroll bar on the right of the screen.

Using the mouse and the mouse button, select an icon and click on “Select” to
confirm your choice. You will be returned to your working screen with the selected icon in
the middle of the frame.
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To move the icon, point at it with the cursor, then click and hold the mouse button
while dragging the mouse until the icon is where you want it. Release the button and the
icon will be set in place.

lﬁ File Edit Goodies Graphics Special

You may repeat this procedure as many times as you wish and place as many icons as
you want on the screen.

Now let’s use the Toolbox displayed at the left of the screen. Move the cursor to the
upper right corner of the toolbox and select the “A” square.

il
X
il
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Now pull down the Graphics Menu and select “Font™. A window with all the fonts,
sizes and styles available will appear on the screen.

Font:

Geneva
Helvetica
Hew York

Shaston

Times

Venice
Style: Size: Other
(CI1Plain ;| Size:

Outline
Shadow b E 0K m

Select “New York™ in the Font window, “Bold™ in the style window. and “18™ in the
Size window. Click on “OK” to confirm your selection.

Finally, you can choose a color for the text by moving the mouse to the lower part of
the toolbox and selecting the color you want to use for your message.

To actually write your text on the screen, move the cursor with the mouse and click
on the spot where you want your message to start.
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Then type the sentences shown in the picture below. Press Return when you have
finished each sentence, then select the “A” square again to type the next text.

3

Point to your icon and click the mouse button to select it. Now pull down the Edit
menu and click on “Cut”. Your icon disappeared! Don’t worry, it hasn't been lost.
ShowOfT is keeping it in memory for you. Pull down the Edit menu again, and this time
click on “Paste”. Your icon is right back where it was. Click on the icon and move it to
another part of the screen, then select the Paste function again to make a copy of your icon.
You can also use “Copy’ on the Edit menu instead of Cut to make duplicates of your icons
without removing them from the screen. Continue making copies of your icons until you
have a total of six on the screen, and arrange them so that one is at each end of each of the
sentences you typed earlier.

% File Edit Goodies Graphics Special

1ip Horizontal
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Now select the icon to the right of the sentence “Vertical Flip”. Pull down the
Goodies menu and click on “Flip Vertical”. Notice how the left and right sides of the icon
have changed places. Next select the icon next to “Horizontal Flip”, then pull down the
Goodies menu and click on “Flip Horizontal”. This time the top and bottom of the icon
have been switched.

.ii File Edit Goodies Graphics Special

Your first frame is completed, and you are ready to move on. Pull down the Edit
Menu and select “Next Frame”. This will record your work as the first frame of a sequence
and present a blank screen for your second frame.

|4k File 138 Goodies Graphics Special |

s e .
iAE D

Clear Frame :

FAPVES
.08 %

o 2 o
Ge g it

b
A e
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rl
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g o

Icon
Label
Template

Sequence

One of ShowOff’s powerful features is the ability to import graphics from other
programs. In this second frame you are going to use a full screen image created with a
paint package. Select “Load Picture” in the File Menu. The standard ProDos dialog box
will appear with the names of the available bitmap files on the disk.

Select the picture named “Imagel” by clicking on the name, and then on “Open”.
ShowOff will load the picture and return to the Frame Editor.



You will be able to add all of the ShowOff custom elements the same way you did
with your first frame: borders, icons, and text.

The City of San Francisco

,,,,, | } i
i il ! i ! }
g i o
i i &

: :
S i i i i i i
The business, the fun... The [ife!

Now that you have two frames to work with, it’s time to edit your sequence. Select
“Sequence” in the Edit Menu. A window will appear with your two frames in the upper
left corner of the screen, and the editor’s functions on the right side. You will also notice
that each frame’s number is in the upper right corner of its image.

Save
Save as
Revert

Print

Show

m-| | _:
a ||}

2
RS

T

. Note: If you want to go back to frame | to edit it (change some part of it), just click
on the rectangle marked 1 and select Edit. You will be returned to the Frame Editor with
frame | on the working screen.

13
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Select the option “Renumber” and the numbers will disappear. Click on the seco'.d
frame (previously number 2) and a “1” will appear where there was a “2” before. Now
click on the first frame, and a “2” will appear where there was a “1” before. Click on
“Done” and the sequence will be re-ordered as you have just directed.

Now you should save your sequence to disk. Select “Save”, and your sequence will
be saved under the name you gave at the beginning of this session.

You will want to see the result of your work, so select “Show” in the Sequence Editor,
and the following window will appear:

Show
@ Automatic Time:

2 Manual

> Jump to Frame: [:I

Select “Automatic” and click on “OK”, and the show will begin. (Note: You can
select icons and move them on the screen during the show.) To quit the “Show” mode,
press the “Esc” key.

You have just created your first presentation with ShowOff!!!



THE FRAME EDITOR

THE TOOLBOX

Move

Text

A

Stickers

Icons
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The Frame Editor is at the center of ShowOff. In the Frame Editor you will design
and assemble the frames that make up your sequence.

In addition to the pull-down menus in the Frame Editor, there is a Toolbox that
provides the most frequently used procedures. Pressing the Space Bar will alternately
display the Menu Bar and Toolbox and remove it from the screen. Many of the functions in
the Toolbox are duplicated on the menus. Let’s take a look at the tools.

When you select Move from the Toolbox, you can click on any object in the frame
and drag it to a new location. This option is the default selection when you enter the Frame
Editor. With this function, you can also select several objects to move at on time (see
Selection and Priorities at the end of this Chapter). When an object is selected, small
squares are displayed at the corners of the object. By clicking on these squares and
dragging, you can adjust the size of many of the objects except the Icons and the Stickers.

The Text option allows you to type text on the screen. The Font option in the Graphics
Menu determines the appearance of the letters, and the color selection from the palette
controls the color. You can change colors while typing and create multi-colored text on the
screen. Once the text has been entered it is treated as a single object subject to all the
manipulation possible with any object. If you select a text object and then click on a new
color, all of the text will become the new color, even if it was multi-color before. Press
Return or click on Move to end text entry.

Clicking on Stickers in the toolbox will display the Sticker Selection Window. Click
on any sticker to select it. Clicking on Select will take the selected sticker and return to the
Frame Editor. If you decide not to select any stickers, click on Cancel. This option is
duplicated on the Graphics menu and your options are further explained in that section.
(See page 22)

Clicking on Icon in the Toolbox will display the Icon Selection Window. Click on any
icon to select it. Clicking on Select (or double-clicking on the mouse) will take the
selected icon and return to the Frame Editor. This option is duplicated on the Graphics
menu and your options are further explained in that section. (See page 22)



Lines

™

Cut

%

Flip Vertical

Geiedr

Flip Horizontal
<

Hollow Shapes

-

Filled Shapes

G

Arrows

i1

Line Width

Colors

Frame Number

1

Previous/Next Frame

-
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Clicking on Lines in the Toolbox will allow you to draw lines on the screen. Place the
cursor where you want one end of the line, press and hold the mouse button. Move the
cursor to the other end of the line and release the button to draw the line. You can adjust the
location of this end point while you hold down the mouse button since the line will not be
set until you release the button. Lines that you have drawn are objects that can be selected,
moved, cut or resized.

After selecting an object on the screen (by clicking on it), you may cut that object off
the screen by using this option. Don’t worry, the object is not totally lost, the program
keeps it in memory until you use this function (or the Copy function) again. This option
can also be activated by pressing “GX” on the keyboard.

This option will allow you to flip a selected object (Icon, Sticker, or Business
Graphics) around a vertical axis, as if you were using a mirror. This command exchanges
the left with the right. This option is duplicated on the Goodies Menu.

This option will allow you to flip a selected object (Icon, Sticker, or Business
Graphics) around a horizontal axis, as if you were using a mirror. This command
exchanges the top with the bottom. This option is duplicated on the Goodies Menu.

Clicking on any of the three hollow shapes at the left of the Toolbox will allow you to
put that shape on the screen. To draw one of the rectangles, place the cursor where you
want one corner of the shape. Press the mouse button and hold it while you drag the cursor
to the opposite corner. To draw an ellipse, imagine you are going to draw a rectangle that
will just contain it, then use the same procedure as you would for the rectangle.

The figures are drawn in the same manner as the Hollow Shapes described above.

Note: If you hold the Command Key while drawing any of the shapes (lines, hollow
shapes, or filled shapes), ShowOff will restrict the proportions of the shapes. The
rectangles will produce perfect squares, the ovals will draw perfect circles, and the
lines will be horizontal, vertical or at a 45 degree angle.

When you click on the arrow pointing up, the lines you draw will have an arrow head
at the last point you set. When you select the arrow with two points, both ends of the lines
you draw will have arrow heads.

The five lines of different thickness set the width of the lines you draw and the borders
of your filled shapes. If you select the dotted line, filled shapes will have no borders.

The color palette allows you to select from the sixteen available colors for your text,
lines and shapes. Select the object whose color you want to change, then click on the color
that you want in the palette. To change the border color of a filled shape, press the

Command key while clicking on the new color.

The number of the frame you are working on always appears at the bottom of the
Toolbox.

If you click on the arrow to the left of the frame number, the frame you are working
on will be stored, and the previous frame in the sequence will be loaded for you to edit. If
you click on the right arrow, the frame you are working on will be stored and you will be
able to work on the next frame in the sequence.



THE FILE MENU

New

Open

Load Picture

Save

Save As . .

Save as Bitmap
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Edit Goodies Graphics Special |
New aN

Open ai
Load Picture
Save as
Save As

Save as Bitmap
Print P
Quit a0

Selecting this option will allow you to create a new sequence. ShowOff is designed to
help you create elaborate presentations that may contain many frames. You will not need to
give a name to each frame you create, a single name will apply to the whole sequence.
This option can also be activated by pressing “GN” on the keyboard. A dialog box will
appear asking if you are sure you want to clear all current work. Any frames currently in
memory will be cleared.

Note: You will need blank disks for all your data storage. Do not forget to format a
disk with Mouse Desk before starting the program.

Clicking on this option will allow you to load a previously designed sequence. A dialog
box will appear on the screen, showing the name of the disk and all the files it contains. By
clicking on the arrows, you will be able to read through the list of files. To open a sequence,
just click on the name and then on OPEN. (Clicking twice on the name will have the same
effect). This option can also be activated by pressing “(30” on the keyboard.

If you want your frame to include a very detailed picture designed with a paint
package, this option will allow you to load drawings from the popular paint programs
available for your Apple 1IGs. When the standard dialog box appears on the screen, just
select the name of the picture and click on OPEN or double-click with the mouse button.

Clicking on this option will allow you to save the sequence you are working on. Do
not switch off your Apple IIGs before saving your work, as you could lose all or part of
your sequence. This option can also be activated by pressing “@3S” on the keyboard. It is
a good idea to save your work in progress frequently to avoid accidental loss.

If you want to save the sequence you are working on under another name (or if you
want to create a backup of the sequence), select this option from the File Menu. When the
standard dialog box appears on the screen, just type in the new name for the sequence and
press RETURN or click on SAVE.

Selecting this option will allow you to save the screen you are working on as a picture
to be used by the most popular paint packages available for your Apple IIGs. The standard
dialog box will appear on the screen showing the name of the disk, the space available,
and the names of all the files on the disk. Just type in the name of the picture you want to
save and press RETURN (or click on SAVE).



Print Clicking on this option will allow you to print the frame displayed on the screen. You
can even print your whole sequence if you wish. The following dialog box will appear on
the screen. This option can also be selected by typing “GP”.

Scale
o |
1,4
21716

Display

) One column

#® Two columns

[Cuncel ] ll Ok il

Scale 1: This option will print the frame or sequence full size.

Scale //+:  This option will print a reduced image. (It is the default option when you
click on Print in the File Menu of the Frame Editor.) Selecting “One
Column” will print a V4 size screen at the upper left corner of the page.
Selecting “Two Columns” will print six Y4 size screens from your
sequence on each page if that many frames have been selected for
printing.

Scale Yis:  This option will print Vie size screens. Selecting “One Column” will
print a single column of six frames per page, while selecting “Two
Columns” will print two columns of twelve frames.

CANCEL: Click here if you decide not to print after all. You will be returned to the
Frame Editor. b

OK: Click on this box when you are satisfied with your selection and the
following print box will appear.

IMARGEWRITER-PRINTER vi D
Quality: 2 Better Text

@ Better Color

o Draft
Page range:

@ A1l

i From: I:] To: ! !
Copies:

Paper Feed:® Automatic _' Hand Feed

O color (Cuncel ]ﬁr 114 J]

Quit Clicking on this option will leave ShowOff and return you to the Apple IIGS system.
If you have not saved your work, an alert box will appear asking if you want to save your
current work before quitting the program. This option can also be activated by pressing
18 “@3Q” on the keyboard.
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THE EDIT MENU

Undo

Clear Frame

Cut

Copy

Paste

Icon

Label

Template
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(e File fXil8Y Goodies Graphics Special I
Undo aZ

Clear Frame
Cut ax
Copy aC
Paste “3
Icon

Label
Template
Sequence
Next Frame

Clicking on this option will return your frame to the way it was before the last
function used. This option can also be activated by pressing “GZ” on the keyboard.

This option will allow you to clear the screen. An alert box will appear asking you if
you really want to erase all the objects on the screen.

After selecting an object on the screen (by clicking on it), you may cut the object off
the screen by using this option. Don’t worry, the object is not totally lost. The program
keeps it in memory until you use this function again. (Or until you use the Copy function.)
This option can also be activated from the Toolbox or by pressing “G X" on the keyboard.

Note: If you use the CUT command twice, the first object will be lost. ShowOff
keeps only the most recently cut object in memory.

This command will make a copy in memory of a selected object, without removing
the object from the screen. You use this command in the same way as the CUT command,
but the selected object stays on the screen. This option can also be activated by pressing
“@C” on the keyboard.

After Cutting or Copying an object, you can use this command to paste the object to
a desired spot on the screen. This option can also be activated by pressing “ V" on the
keyboard.

Even though ShowOff includes a huge library of icons, you may wish to modify the
graphics provided with the program or to create your own graphics (for a company logo, a
presentation on a very special topic, etc . . . ). ShowOff allows you to use your talents in
the Icon Editor. Selecting Icon in the Edit Menu will allow you to modify a selected Icon
or even to create one from scratch. You will find much more information on this option and
a detailed explanation of the editor’s features in Section 3 of this manual: THE ICON
EDITOR.

Clicking on this option will allow you to use all the custom graphics functions of
ShowOff to design and print disk labels for your Data or Autorun disks. You will find
much more information on this option and a detailed explanation of features in Section 5
of this manual: THE LABEL EDITOR.

The template function allows you to create a background picture that is automatically
repeated in all the frames of your sequence. All the functions available in the Frame editor
are available to create the Template (Background, Borders, Icons, Stickers, Shapes,
Graphs, etc . . . ). After completing your Template, just select Frame in the Edit menu
and you will be returned to the Frame Editor. The template will be displayed as a
background image behind all the frames of your sequence. You can modify your template
at any time by choosing the Template function again. Your changes will be automatically
repeated throughout the sequence.



Sequence

Next Frame

THE GOODIES MENU

Flip Vertical

Flip Horizontal

Bar Graph
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Selecting this option will transfer you to the Sequence Editor where you will be able
to edit and rearrange the frames in your sequence. You will find much more information
and a detailed explanation of the editor’s features in Section 4 of this manual: THE
SEQUENCE EDITOR.

Clicking on this option will allow you to begin working on the next frame in your
sequence.

ek File Edit KELLL XN Graphics Special ]
Flip Vertical
Flip Horizontal
Bar Graph

Sale Graph

Pie Chart
Shadow

Auto Numbering

This option will allow you to flip a selected object (Icon, Sticker, or Business
Graphics) around a vertical axis, as if you were using a mirror. This command exchanges
the left with the right.

This option will allow you to flip a selected object (Icon, Sticker, or Business
Graphics) around a horizontal axis, as if you were using a mirror. This command
exchanges the top with the bottom.

Clicking on this option causes the Graph Editor Window below to be displayéd.

Graph Editor

1
B

[Compute]
Bar Graph  (Tancel)
[C] Sale Graph
] Pie Chart

On the left part of the screen, you may enter up to 12 numbers (positive or negative).
Use the mouse or the “Tab” key to move the cursor to a néw line. Click on “Compute’ or
press Return, and ShowOff will draw a graph of your numbers on the right side of the
screen. You can modify any value and ask for a new computation. You can even change the
colors of the bars by using the palette at the bottom of the screen. When you are satisfied,
click on “OK™ and you will be returned to the Frame Editor with the Bar Graph on the
screen. Graphs are objects that can be resized or manipulated just like any other object.
(You can also change the color and width of the lines using the Toolbox.)



Graph Editor :

= Bar Graph
[C] sale Graph
] Pie Chart

Sale Graph This option is used in the same way as Bar Graph. When the Graph Entry Window
appears, you can enter up to 12 numbers and ShowOff will draw a sale or line graph for
you.

Pie Chart Selecting Pie Chart will allow you to use the same procedure as for bar graphs and

sale graphs. ShowOff will draw a pie chart using your values.

Graph Editor

(] Bar Graph
[C]Sale Graph
Pie Chart

Note: If you have created a graph and you would like to see how the other types of
graph would look, you can click on the existing graph, and select another type of
graph in the Goodies menu. The Graph Editor will be displayed, and a new graph
will be drawn using the same numbers.

Shadow Clicking on this option allows you to turn shadowing of selected filled shapes and
graphs on or off.

Auto-Numbering If you select this option and turn Auto-Numbering on, the frame number for each
frame will be displayed as part of the screen. The frame number is an object, and can be
manipulated like any other object. When Auto-Numbering is turned off, frame numbers

21 will not be displayed.
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THE GRAPHICS MENU

Background

Sticker

Icon
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| ek File Edit Goodies op Special |
Background &6
Sticker
Icon 1
Border 2B

Ho Border
Show Template
Fonts crF

This option allows you to select the color for the background of your frame. A dialog
box will appear with the 16 color selections available. Just click on the one you want to use
then click on “OK”. This option can also be activated by pressing “* GG on the keyboard.

Clicking on this option will display the Sticker Selection Window. Click on any
sticker to select it. Clicking on Select (or double-clicking with the mouse) will take the
selected sticker and return to the Frame Editor. If you click on Other, a dialog box will
appear allowing you to import stickers from any library disk of Print Shop compatible
graphics. Just select the graphic you want and click on Select. If you click on the box
labeled “From Print Shop”, ShowOff will display the graphics from you Print Shop
program disk in groups of eight for you selection. If you decide not to select any stickers,
Cancel will return you to the Frame Editor.

[ See more choices ] [Fl"ﬂll‘li Print Shop disk]

ShowOff provides more than 380 different icons to illustrate your presentations, and
if you want more, you can also design your own. (See Section 3: THE ICON EDITOR.)
To select an icon from the library included with ShowOff, just select Icon from the
Graphics Menu and the Icon Selection Window will appear. Note that the name of the
current Icon Library page appears in the upper right corner of the screen. You can use the
scroll bar to view all the available icons. Select an icon by clicking on it. The Icon option
can also be activated from the Toolbox or by pressing “(G I on the keyboard.
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Select: When you click on “Select”, your chosen icons will be taken to the

Frame Editor.

Add: Clicking on “Add” will allow you to load a new Icon Library file from a
library disk. (Due to memory limitations, you can work with only 20

icon files at once.)

Remove: This option allows you to delete a page of icons from the current list. By
doing so you will be able to create a personalized list of icon files and
remove the ones you don’t want to 11se in your sequence.

Cancel: If you decide not to select any icons, Cancel will return you to the Frame

Editor.

Select an Icon

Alphabet

[ Select )

)

”’lf-':

Border

ShowOff provides a library of 144 pre-designed borders to be used for giving a

personal touch to your frames. Selecting BORDER in the Goodies Menu will display the

following screen:

Select a Border

}] iy
ﬁ,mm.v,'lgfmu

Dl e




You can use the scroll bar to examine the available borders, and when you have found one
you like, select it by clicking on it and on Select. It will become the border for your frame.
If you decide not to select a border, Cancel will return you to the Frame Editor. This option
can also be activated by pressing "G B” on the keyboard.

No Border If you decide your frame looked better without a border, just select this option and the
border will be removed from the screen.

Hide Template If you have created a template, this option allows you to create a frame that does not
use the template established for your sequence. The frames before and after a frame where
you have used this function will still show the template.

Font Clicking on Font will open a window which lists all of the fonts, sizes, and styles
available for use with your typed text. Click on whatever features you would like to use,
then click on “OK” to confirm your selection. If you don’t want any of the sizes shown
after you have selected a font, clicking on the “Other Sizes” box will allow you to enter a
value and ShowOff will adjust the font to your chosen size.

THE SPECIAL MENU |ofk File Edit Goodies Gru:hicsm___l

Serial Setup“

Serial Orders
Transition

Serial Setup When you select this option, a dialog box appears allowing you to set the
communications parameters used by the serial port of your Apple IIGs. Consult the User
Manual for the printer or other peripheral you will be using to determine the settings to

choose.
Setup serial ports
@ Printer  Modem
Baud Data bits Parity :Stop bits
300 @ 8 bits @ None @ 1
@ 1200 (7 bits O Even 2
O 2400 < odd
LW8o0o
< > Add CR after command
9600 A
19200
[ ok ] (cancel )
Serial Orders If you are using a Carousel projector or other remote-controlled device with your

Apple lIcs and ShowOff, this option opens a window where you can enter the commands
you want that device to follow. Consult the User Manual for your machine to find the
commands it understands. ShowOff will transmit any order through the serial port to the
attached device.
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Transitions

W %&jf *Z“*‘WWPWW i
s o L

[ Edit )

[ Add )

1 12345

| 123u56 | (Inserc)
| 1234567 [ Clear ]
[Lz3 il
& Wai @ Click Mouse @ Modem
i bWait _ -
3 Time - POrt . ~ printer

|I Ok Il [ Cancel ]

hs— — — — —

When you select Transitions, ShowOff’s powerful transitions editor will appear. For
each frame, you can designate up to five different transitions from ShowOff to use when
leaving that frame in a show. Which transition is used is determined by the keypress you
make while the frame is being shown. In the first column you can select the number of the
frame in your sequence to be shown next. In the second column, enter the keypress that
will cause that transition to be used. The third column allows you to choose the type of
transition for ShowOff to use. The available effects are: fade to black, fade to white, scroll
up, scroll down, scroll left, scroll right, and fade to next frame.

Transition
Frame : 1
To Key Effect
2 Any aldjo -
L1 L1 afle
[ 1 L[ Ao
1 L[ aw
1 L[ aflw

[ ok ] [Cancel]




2.

SELECTION & PRIORITIES

Multiple Selection

Object Priorities
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ShowOff allows you to put objects on top of each other, and to manipulate several
objects at once. ShowOff’s rules of selection and priority will affect how your frames
appear. To select an object, point to it with the cursor and click the mouse button. A
selected object is identified by small squares at the corners.

You can select several objects at once by clicking the mouse button over an open
space in the frame and dragging the mouse across the desired objects, releasing the button
when all of the objects are completely enclosed by the selection rectangle. When you
select several objects at once, your movements and commands will affect them all equally.
Their relationships to each other will remain unchanged.

When objects in your frame overlap or when one object is directl,;q)n top of another, the
object with the highest priority will appear to be in front. The bgekground or template for a
frame has the lowest priority and always appears in back. Next comes thg border, followed
by shapes and lines, graphs, icons and in front of everything{ text which
in front. When objects with the same priority level overlap, the most reeently selected one
will appear in front. The chart below help to clarify the priority Ievels.

Always in back Template, Background
Level 5 Border

Level 4 Shapes and lines

Level 3 Graphs

Level 2 Icons

Always in front Text




THE ICON EDITOR

Pencil

Selection

Lines

™

Text

A
Flip Vertical
+|+
Flip Horizontal

e
*
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When you select Icon from the Edit Menu of the Frame Editor, the Icon Editor screen
will appear. Here you can modify any of the existing icons or create a new one from scratch.

L
il
i

Select.l Quit I

The Icon Editor includes a Toolbox, several buttons, and two displays of the icon you
are working on. The large window is the editing area where you will do your actual drawing.
The smaller window shows the Icon actual size. Each icon is 39 pixels wide and 27 pixels
high. Now let’s look at the Toolbox.

When you click on the Pencil you can draw in the large editing window. Each time you
click and release the mouse button the little square at the point of your tool will be colored
in the selected color. If you click and hold the mouse button while dragging the mouse
around the editing window, you can draw freehand shapes.

Clicking on Selection will allow you to capture a portion of the ican in the window.
Place the cursor at one corner of the area you want, click and drag the cursor across the area
to the opposite corner, then release the mouse button. Several of the other features of the
Icon Editor will operate on the selected part of the icon or on the entire editing window when
there is no selected area.

Clicking on Lines will let you draw straight lines in your icon. Place the cursor where
you want one end of the line, click the mouse button, move the cursor to where you want
the other end, and click again. You can adjust the location of this end point while you hold
the mouse button. The line will be set when you release the button. ShowOff will draw a
straight line for you.

If you select Text, you will be able to type letters on your keyboard and have them
appear in your icon.

Clicking on Flip Vertical will flip your icon around a vertical axis, exchanging left for
right. If you have selected a part of the icon, only the selected area will be flipped.

Clicking on Flip Horizontal will flip your icon around a horizontal axis, exchanging
the top and bottom. If you have selected a part of the icon, only the selected area will be
flipped.
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Hollow Shapes

Filled

BUTTONS

Cut

Copy

Paste

Load

Save

Revert

Clear

Undo

Select

Quit

Selecting any of the hollow shapes at the left of the Toolbox will allow you to draw
the shape in your icon. Place the cursor where you want one corner of the shape, click and
drag the mouse to set the size and proportions of the shape.

Selecting any of the filled shapes at the right of the Toolbox will let you draw the
shape in your icon. Draw the shape the same way you draw the hollow shapes. If you
double click on the filled shape icon, a dialog box will appear allowing you to select the
border and fill colors for the shape.

You can scroll your entire icon in any of the four directions, one pixel at a time, by
clicking on the arrow pointing in that direction. If you have selected a part of the icon, you
can scroll that part.

You can choose the color for your lines, shapes, or pencil by clicking on any of the 16
available colors. Holding the Option key while selecting a color will change the border
color of a selected filled shape.

Now let’s take a look at the operation of the Buttons along the right side of the Editor
screen.

After using the selection box, if you select the Cut button, you will remove the
selected portion of your icon from the editing window. Don’t worry, the material is not
totally lost, the program keeps it in memory until you use this function (or the Copy
function) again.

When you select the Copy button, you can make a copy in memory of the selected
part of the icon. You use this option the same way you use Cut, except the copied area is
not removed from the editing window.

Clicking on Paste will paste whatever was Cut or Copied most recently into the
editing window at the current cursor location.

Clicking on Load will cause the Icon Selection Window to be ;displayed. In the Icon
Selection Window, you can select an icon to edit. For a detailed description of the features
of the Icon Selection Window, refer to Section 2: The Frame Editor.

When you click on Save, you will be able to save your icon to a User Icon File on
disk. Each User Icon File can hold 35 icons. To create a User Icon File, click on New, and
a dialog box will appear, allowing you to choose a name for the new file. Then a blank
screen will appear, just click on the spot you want your icon to be put. Then click on OK.

. Selecting Revert will restore the original version of an icon you have been modifying.
This option will only work with an icon that has been loaded from the Icon Selection
Window.

Selecting Clear will clear the Icon Editor’s work area and give you a blank slate to
work on.

Clicking on Undo will always restore your icon to the way it was before the last
operation.

Clicking on Select will allow you to return to the Frame Editor with the changes to
your icon. However, the changes will not be saved to disk.

Clicking on Quit will return you to the Frame Editor. If you have not saved the icon
you have been editing, a dialog box will appear asking if you want to abandon it.



THE SEQUENCE EDITOR

Using the Sequence Editor

New

Cut

Copy

Paste

Edit

Renum

Open
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When you select Sequence in the Edit Menu of the Frame Editor, the Sequence Editor
window will appear. Using the Sequence Editor, you can rearrange the order of your
frames, cut or copy whole frames, run a slide show of your sequence, or create an Autorun
disk so that friends and associates can see your show.

The Sequence Editor window displays up to twelve frames on the left side of the
screen. You can select any frame simply by pointing to it with the cursor and pressing the
mouse button. If there are more than twelve frames in your sequence, you can move
through them by using the scroll bar at the right of the frame display. Along the right edge
of the screen are the functions of the Sequence Editor.

0

Cut
Copy

P o e
Foaagte

A Edit

il

Renum
Open
Save

Save as
Revert

Show

H

e

&

Selecting New will insert a new blank frame after the selected frame.

Clicking on Cut will remove the selected frame from your sequence and renumber the
remaining frames. This option can also be selected by typing “ X,

Clicking on Copy will make a copy of the selected frame in memory so that identical
frames can be inserted into your sequence. This option can also be selected by typing

“4C

Clicking on Paste will insert the most recently cut or copied frame into the sequence.
This option can also be selected by typing “BV”.

If you select a frame and then click on Edit, you will be returned to the Frame Editor
with the selected frame on screen ready for you to make changes.

When you select Renum, which stands for Renumber, the frame numbers will be
cleared. By selecting one frame after another you can establish a new order for your
sequence. Click on “DONE” when you have finished arranging your frames to set the new
numbering.

Selecting Open will allow you to load a previously created sequence from disk. A
dialog box will appear displaying the name of your disk and all of the sequences it
contains. Select the sequence you wish to edit and click on “Open” to confirm your
selection. This option can also be selected by typing “BO”.



Save Selecting Save will save the sequence you have been editing to disk. This option can
also be selected by typing “GS”.

Save As: Clicking on Save As: will allow you to save your sequence under a new name. A
dialog box will appear displaying the name of the disk and all of the sequences it contains.
Just type the new name you want to use and click on Save or press Return.

Revert If you decide that the changes you have made in a sequence are not what you wanted,
clicking on revert will restore the sequence to its original state. This function will only
work if the sequence has previously been saved.

Print Selecting Print will display the Print Dialog Box where you may select from several
printing options. This function is more fully described under the File Menu in Section 2 of
this manual, “The Frame Editor”. This option can also be selected by typing “GP”.

Show When you click on Show, the Show Window will be displayed. In the Show Window
you will have several choices available for displaying your finished sequence.

Show
#® Automatic Time:

.2 Manual

i Jump to Frame: I:I

Display all Frames in Order Selecting this option will show the frames of your sequence in the order you have
arranged them. You will be able to modify the show by using the following options:

Automatic . When ShowOff runs in Automatic mode, each frame will be displayed
for the same length of time. After clicking on Automatic, type the
number of seconds you want each frame to be on screen.

Manual ~ When Manual is selected ShowOff will continue to display each frame
until you press a key on the keyboard to request the next frame. Pressing
the right arrow on the keyboard or clicking the mouse button near the
right edge of the screen will move to the next frame in the sequence.
Pressing the left arrow or clicking near the left edge of the screen will
more to the previous frame.

Jump  Clicking on Jump will allow you to go directly to any frame you choose.
Just type the frame number where you want to begin.

Note: At any time during the show, whether in ShowOff or using the Autorun disk,
you can press the ESC key which will stop the show and allow you to change the
Show options.
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Create an Autorun Disk
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ShowOff makes it easy for you to create an Autorun disk that you share with your
friends and associates. The Slide Show Disk included with ShowOff contains all the
run-time routines needed for a show. It is not copy protected, so you can make as many
copies of it as you wish. To make an Autorun disk, simply place the Slide Show Disk or a
copy of it in your disk drive, and select the “Save as” option in the File menu of the Frame
or Sequence Editor. You can also create an Autorun disk from ProDos by copying the files
used by your sequence onto a Slide Show Disk. The necessary files will all have names
beginning with your sequence name, but they will have a variety of different extensions.



THE IABEL EDITOR

THE TOOLBOX

THE FILE MENU

THE EDIT MENU

THE GOODIES MENU

THE GRAPHICS MENU

MAKING A LABEL
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When you select Label in the Edit Menu, the Label Editor screen will be displayed.
The Label Editor provides all the graphic and text features of the Frame Editor for use in
making custom labels for your data disks and Autorun show disks. When you have
designed your label, you can print it one quarter of the screen size (about 2% by 2/4™) and
attach it to your diskette.

3.5" Data Disk
September 1987

b & =

The Toolbox in the Label Editor is the same as the Toolbox in the Frame Editor except
that it does not display the frame number or provide the Previous Frame/Next Frame
arrows at the bottom. All the other tools will perform in their usual way.

The File Menu in the Label Editor provides most of the same functions as the File
Menu in the Frame Editor, except for the Print feature. This option does not provide the
variety of choices available from Print in the Frame Editor. Selecting Print will print the
label V4 the size of the screen image )

The Edit Menu in the Label Editor provides most of the features of the Edit Menu in
the Frame Editor, except for the Template, Sequence, and Next Frame functions that are
not available. Notice that they appear in grey.

Except for the Auto Numbering feature, The Goodies Menu in the Label Editor
provides most of the same functions as in the Frame Editor, except. Notice that this feature
appears in grey in the menu.

Except for the Show Template option, the Graphics Menu in the Label Editor
provides most of the same functions as in the Frame Editor. 5.

The procedure for making a label exactly parallels the procedure for making a frame.
To see the features of the Label Editor, let’s make a label for your ShowOff data disk. With
ShowOff running and the Frame Editor on the screen, pull down the Edit Menu and select
Label to enter the Label Editor. Next, pull down the File Menu and click on New. When
the File Selection Window appears, type in a name for this label that will clearly identify
it for you.



Now you are ready to begin designing your label. Begin by selecting Border from the
Graphics Menu. When the Border Selection Window appears, select a border that you
would like to use. Back in the Label Editor, select Icon from the Graphics Menu. Locate
the icon of a movie camera and select it. Move it to the upper left corner of the label.

Next click on Text in the Toolbox, and use the Font Menu to select “New York”,
“Bold”, and “18 Point”. Now type “ShowOff” and “Slide Show Disk” in your label. Using
the Font Menu, change from “Bold” to “Normal Text” and from “18 Point” to “8 Point™.
Next type “Date: _/__/__" in your label. Drag the four objects around the screen until
your label looks balanced and attractive. Use “Save” to store your label on disk for future
use, then select “Print” and you will have your first label.

..nn 1SS0 ST SIS SO TS IS A St s et | 101,
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ShowOff
Slide Show

Disk

Date._~_/~_

i
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EXAMPLES Here are some examples of other labels you might want to use. Of course, you can
create almost any label you can imagine with ShowOff.

Show0ff lcon Data Disk
September 1987

This label could be used for a disk containing all your personnal icons or for a library
of graphics done with a Paint program.
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Sales in the last foun

Quarters

In this label, a Sales Graph has been combined with a businesslike border and font to
maintain the professional style of the business presentation on the disk. This type of label
could be used for any disk containing business information.

Here is a label a student might use for a research report at school. With ShowOff. oral
reports can become interesting, stimulating audio-visual sessions.
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6. CREATIVE IDEAS

ShowOff is designed to unleash your creativity. Possible uses for your frames and
sequences can be found anywhere from the nursery room to the schoolroom to the
boardroom. Here are a few suggestions to start your imagination working.

Q&A Using ShowOff, you will be able to display a series of questions for an audience, and
then reveal the hidden answers.

~ Science Q'uiz #4
1) Who Discovered DNA ?
Sﬁ a] Crick.....English 4
b|Watson...USA

c |Wilkins..English

d | All of the above

Text can be hidden by putting it into the template and covering it with a filled shape,
or by giving it the same color as the background (or as a filled shape behind it).

Science Quiz ¥4
1) Who Discovered DNA

7
A La] Crick...... Engllshﬁ
» M

b | Watson...USA
¢ |Wilkins..English

d | All of the above

35
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MORE Q & A

Using the very powerful Transition function of ShowOff (See the Special Menu in
Chapter 2), you will be able to create an interactive slide show, where your audience can
immedialty get the result of the choice she made.

1. ¥hich President is known as
the father of our country?

a) Abe Lincoln
b} Thomas Jefferson

c) George Washington

Press the appropriaote letter on
the keyboard for the correct answer.

Answer:

3

Your choice was not correct

Please try again

Quiz ¥2 3




If your audience select “c” (the right answer), your computer will then display the
following screen:

Answer:

You are correct

Congratulations!

_Quiz #2

This amazing result can be obtained by simply introducing the following commands
in the transition window of the first frame (the one with the questions):

Transition

Key Effect
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GIFT TAG You can use the power of ShowOff ’s label editor to create unusual, personalized gift
tags for any occasion.

s =\
appy
To : Bobby
From: Tim & Carol
. o
Using the Arrows When there are a number of objects in the frame, you can direct the audience’s

attention where you want it by using arrows as pointers. Remember, the arrows, like any
object, can be moved around the screen or redirected at any time.

Helicopter

Balloon

Supersonic Jet

Jumbo Jet
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Football Coaching The football coach could teach the team new plays using diagrams like this and
ShowOff. The icons representing players can be moved around on the screen while team
members watch. Arrows can show running patterns.

Football Chart—¥)
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REBUS You can create amusing rebus or illustrated sentences by substituting ShowOff’s icons
for words.

New York

6

We ride the i to school
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PUZZLES

By using ShowOff’s ability to import full-page pictures into the icon library then
scattering the pieces around a frame, you can create challenging picture puzzles. To do
that, select Icon in the Graphics Menu, then choose Add, and instead of loading a
standard icon file, select a picture. You will now be able to take parts of the image and put
them on the screen, as you would usually do with icons. (If you want your puzzle to be
really difficult, use the Flip Vertical , and Flip Horizontal options).
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7. THE ICON LIBRARY

ShowOff provides a library of over 380 icons for you to use. The next few pages give
you a quick reference to all of them.

Alphabet
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Activities
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Transportation

46

e canned from original document : Apple Museum "Quart de Pomme"2011



8. THE BORDER LIBRARY

ShowOff provides 144 borders for your frames. The next two pages provide you with
a quick reference to all of them.

Borders #1
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Brgderbund warrants for a period of ninety (90) days following the original retail
purchase of this copy of ShowOff that the program is free from substantial errors or defects
that will materially interfere with the operation of the program as described in the enclosed
user documentation. This policy applies to the initial purchaser only.

If you believe you have found any such error or defect in the program during the
warranty period, call Brgderbund’s Technical Support Department, (415) 492-3500
between the hours of 8 a.m. and 5 p.m. (Pacific time), Monday through Friday.
Brgderbund technical personnel will attempt to help you correct or avoid the problem. If
any such error or defect cannot be corrected or reasonably avoided by the customer,
Brgderbund will inform you how to obtain a corrected program disk (or, at Brgderbund’s
option, Brgderbund may authorize refund of your purchase price). This warranty gives
you specific legal rights, and you may also have rights which vary from state to state.

If any disk supplied with this product fails within ninety (90) days of purchase for any
reason other than accident or misuse by the customer, please return the defective disk
together with a dated proof of purchase to Brgderbund Software-Direct, 17 Paul Drive,
San Rafael, CA 94903-2101, for a free replacement. This policy applies to the original
purchaser only. Brgderbund will replace program disks damaged for any reason, whether
during or after the ninety (90) day free replacement period, for $5 per disk plus a postage
and handling charge of $2.50 per request, as long as the program is still being
manufactured by Brgderbund.

Unauthorized representations: Brgderbund warrants only that the program will
perform as described in the user documentation. No other advertising, description, or
representation, whether made by a Brgderbund dealer, distributor, agent, or employee,
shall be binding upon Brgderbund or shall change the terms of this warranty.

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, BR/DERBUND
MAKES NO OTHER WARRANTY, EXPRESS OR IMPLIED, REGARDING THIS PRODUCT.
BRODERBUND DISCLAIMS ANY WARRANTY THAT THE SOFTWARE IS FIT FOR A
PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF MERCHANTABILITY
SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS LIMITED EXPRESS
WARRANTY AND IS OTHERWISE EXPRESSLY AND SPECIFICALLY DISCLAIMED. SOME
STATES DO NOTALLOW LIMITATIONS ON HOW LONG IMPLIED WARRANTY LASTS, SO
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES: BRODERBUND SHALL NOT BE LIABLE FOR
SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES, EVEN IF
BR@DERBUND IS ADVISED OF OR AWARE OF THE POSSIBILITY OF SUCH DAMAGES.
THIS MEANS THAT BRODERBUND SHALL NOT BE LIABLE FOR LOST PROFITS OR
REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A RESULT OF LOSS OF TIME,
DATA , OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE EXCEPT THE
ACTUAL COST OF THE PRODUCT. IN NO EVENT SHALL BRODERBUND'’S LIABILITY
EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SOTHE
ABOVE LIMITATION MAY NOT APPLY TO YOU.

The user of this product shall be entitled to use the product for his or her own use, but
shall not be entitled to sell or transfer reproductions of the software or manual to other
parties in any way, nor to rent or lease the product to others without the prior written
permission of Brgderbund. For technical support, on this or any other Brgderbund product
call (415) 492-3500.

Copyright © 1987 Brgderbund Software, Inc.
17 Paul Drive, San Rafael, California 94903-2101
All Rights Reserved.






BACKUP DISK INFORMATION

51

Scanned from original document : Apple Museum "Quart de Pomme"2011

This program is copy protected. If you would like a backup disk, you may order
one using the coupon below. You may do this at any time, as long as the product is still
being manufactured by Brgderbund. Limit: one per customer.

Please mail the original coupon, not a copy, along with a check or money order for
$10.00 (in U.S. funds), or complete credit card information to:

Brederbund Software Direct
P.O. Box 12947
San Rafael, CA 94913-2947

Please make your check or money order payable to Brgderbund Software.

Backup Disk Coupon

Please Print

Name:

Address:

City, State, ZIP:

Daytime Phone:

(In case we have a question about your order)
Product Name: ShowOff

[J Check/money order [] VISA [J MasterCard [] American Express

HEREEEEEEEEEEEEEEREEER

Credit Card Number Expires

Signature (required for credit card orders)

(Clip this coupon along the dotted line and send along with your payment. Please allow
four weeks for delivery.)
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For more information about Brgderbund and our products, call us at (415) 492-3500.
17 Paul Drive, San Rafael, California 94903-2101
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SERIAL ORDERS

LASER PRINTING
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Nutrition

If you plan to drive a serial device other than a printer and wish to perform special
tasks, you will need to know the following information.

Select the “Serial Orders” option from the “Special” menu. The “Serial Orders”
screen will appear. To enter ASCII codes, click on the edit line and type in the characters.

To enter ASCII codes that are not accessible through the keyboard (i.e. an Escape
or Return), press the “CTRL-Q” keys simultaneously from the Serial Orders window. An
Apple icon will appear in the selection box. Enter the decimal value of the code (for
example — 27 for Esc) and press the “CTRL-Q” keys a second time. Repeat this procedure
if more than one special character must be sent. When done, click on “Add” to save this
information to the frame that is being worked on.

If you are connected to a laser printer, you may use it to print your sequence. Before
printing, the laser printer must be installed using the Apple IIGS system disk.

Thank you for purchasing ShowOff. This product has been designed to enhance your
presentations, no matter what the topic. We are sure you will find using ShowOff entertaining,
productive, and fun!



ShowOff Addendum

ICONS To enhance the quality of presentations, we decided to make a few changes to the
available icons pictured in “The Icon Library” located on pages 41 through 46 of the
manual. The “Animals”, Buildings”, and “Nutrition” screens contain the most substitutions.
Therefore, please refer to the following when searching for available icons:

Animals
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